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Chapter 8
Calculating in Mathcad

This chapter provides an overview of the calculation capabilities of
Mathcad, focusing on defining and evaluating variables and functio
This chapter discusses only numerical equations. To learn how to u
Mathcad’s symbolic processing features, turn to Chapter 14, “Symb
Calculation.”

The following sections make up this chapter:

Defining and evaluating variables
How to define and evaluate variables, including range variables and bui
variables. How the relative placement of equations affects calculations. 
Global definitions.

Defining and evaluating functions
How to define and evaluate functions.

Units and dimensions
Mathcad’s built-in unit capabilities. 

Working with results
Result formatting, converting units in results, copying results.

Controlling calculation
How to suppress the way Mathcad automatically updates the workshee

Animation
How to create and play short animation clips by using the built-in variable 
FRAME.

Error messages
What to do when Mathcad displays an error message.
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Defining and evaluating variables 

When you type an expression into a worksheet, you are usually doing one of two th

■ You could be typing a variable or function name and assigning some value to

■ You could be typing an equation and asking Mathcad to give you the answer

We introduce these topics in this and the following section. See “Evaluating expres
numerically” on page 122 for details on numerical evaluation.

Defining a variable 

A variable definition defines the value of a variable everywhere below and to the r
of the definition. To define a variable, follow these three steps:

■ Type the variable name to be defined. 
Chapter 4, “Working with Math,” contains 
a description of valid variable names.

■ Press the colon (: ) key, or click  on 
the Arithmetic toolbar. The definition 
symbol (:=) appears with a blank place-
holder to the right. 

■ Type an expression to complete the defi-
nition. This expression can include num-
bers and any previously defined variables 
and functions.

The left-hand side of a “:=” can contain any of the following:

■ A simple variable name like x.

■ A subscripted variable name like .

■ A matrix whose elements are any of the above. For example, . This techn

allows you to define several variables at once: each element on the right-hand
is assigned simultaneously to the corresponding element on the left-hand sid

■ A function name with an argument list of simple variable names. For example
. This is described further in the next section.

■ A superscripted variable name like .

vi
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Built-in variables   

Mathcad includes several variables that are already defined when you start Math
These variables are called predefined or built-in variables. Predefined variables either
have a conventional value, like π and e, or are used as system variables to control ho
Mathcad works. See “Predefined variables” on page 347 in the Appendices for a l
built-in variables in Mathcad.

Note In addition to the built-in variables described here, Mathcad treats the names of all built-in units 
as predefined variables. See “Units and dimensions” on page 131.

Although Mathcad’s predefined variables already have values when you start Math
you can still redefine them. For example, if you want to use a variable called e with a 
value other than the one Mathcad provides, enter a new definition, like . The 
variable e takes on the new value everywhere in the worksheet below and to the 
of the new definition. Alternatively, create a global definition for the variable as 
described in “Global definitions” on page 123.

Note Mathcad’s predefined variables are defined for all fonts, sizes, and styles. This means that
redefine e as described above, you can still use e, for example, as the base for natural logarithm
Note, however, that Greek letters are not included. 

You can modify many of Mathcad’s built-in variables without having to explicitly 
define them in your worksheet. To do so, choose Options from the Math  menu, and 
click the Built-In Variables tab on the Math Options dialog box.

To set new starting values for any of 
these variables, enter a new value in the 
appropriate text box and click “OK.” 
Then choose Calculate Worksheet 
from the Math  menu to ensure that all 
existing equations take the new values 
into account. 

The numbers in brackets to the right of 
the variable names represent the default 
values for those variables. To restore 
these default values for the built-in 
variables listed in the dialog box, click 
“Restore Defaults” and then click 
“OK.”

e 2:=
Defining and evaluating variables 121
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Evaluating expressions numerically 

To evaluate an expression numerically, follow these steps:

■ Type an expression containing any valid 
combination of numbers, variables, and 
functions. Any variables or functions in 
this expression should be defined earlier 
in the worksheet.

■ Press the “=” key, or click  on the 
Arithmetic toolbar. Mathcad computes 
the value of the expression and shows it 
after the equal sign. 

Figure 8-1 shows some results calculated from preceding variable definitions.

Figure 8-1: Calculations based on simple variable definitions.

Tip Whenever you evaluate an expression, Mathcad shows a final placeholder at the end of t
equation. You can use this placeholder for unit conversions, as explained in “Working wit
results” on page 134. As soon as you click outside the region, Mathcad hides the placeho

How Mathcad scans a worksheet 

Mathcad scans a worksheet the same way you read it: left to right and top to bot
This means that a variable or function definition involving a “:= ” affects everything 
below and to the right of it.

To see the placement of regions more clearly in your worksheet, choose Regions from 
the View menu. Mathcad displays blank space in gray and leaves regions in you
background color. 
122  Chapter 8  Calculating in Mathcad
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Figure 8-2 shows examples of how placement of equations in a worksheet affec
evaluation of results. In the first evaluation, both x and y are highlighted (Mathcad 
shows them in red on screen) to indicate that they are undefined. This is becaus
definitions for x and y lie below where they are used. Because Mathcad scans from
to bottom, when it gets to the first equation, it has no idea what numbers to subs
in place of x and y.

The second evaluation, on the other hand, is below the definitions of x and y. By the 
time Mathcad gets to this equation, it has already assigned values to both x and y. 

Figure 8-2: Mathcad evaluates equations from top to bottom in a worksheet. 
Undefined variables are highlighted.

Note You can define a variable more than once in the same worksheet. Mathcad simply uses th
definition for all expressions below the first definition and above the second. For expressi
below the second definition and above the third, Mathcad uses the second definition, and

Global definitions 

Global definitions are exactly like local definitions except that they are evaluated bef
any local definitions. If you define a variable or function with a global definition, th
variable or function is available to all local definitions in your worksheet, regardle
of whether the local definition appears above or below the global definition.

To type a global definition, follow these steps:

■ Type a variable name or function to be 
defined.

■ Press the tilde (~) key, or click  on the 
Evaluation toolbar. The global definition 
symbol appears.
Defining and evaluating variables 123
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■ Type an expression. The expression can 
involve numbers or other globally defined 
variables and functions.

You can use global definitions for functions, subscripted variables, and anything
that normally uses the definition symbol “:=”. 

This is the algorithm that Mathcad uses to evaluate all definitions, global and otherw

■ First, Mathcad takes one pass through the entire worksheet from top to botto
During this first pass, Mathcad evaluates global definitions only.

■ Mathcad then makes a second pass through the worksheet from top to bottom
time, Mathcad evaluates all definitions made with “:=” as well as all equations 
containing “=”. 

Note A global definition of a variable can be overriden by a local definition of the same variable n
with the definition symbol “:=”.

Figure 8-3 shows the results of a global definition for the variable R which appears at 
the bottom of the figure. 

Figure 8-3: Using the global definition symbol.

Although global definitions are evaluated before any local definitions, Mathcad e
uates global definitions the same way it evaluates local definitions: top to bottom
left to right. This means that whenever you use a variable to the right of a “≡”:

■ that variable must also have been defined with a “≡,” and

■ the variable must have been defined above the place where you are trying to use 

Otherwise, the variable is marked in red to indicate that it is undefined.
124  Chapter 8  Calculating in Mathcad
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Tip It is good practice to allow only one definition for each global variable. Although you can d
things like define a variable with two different global definitions or with one global and one lo
definition, this may make your worksheet difficult for others to understand.

Range variables 

Iterative processes in Mathcad worksheets depend on range variables. Except for the 
way it is defined, a range variable looks just like a conventional variable. The differe
is that a conventional variable takes on only one value. A range variable, on the 
hand, takes on a range of values separated by uniform steps. For example, you
define a range variable to go from –4 through 4 in steps of 2. If you now use this r
variable in an expression, Mathcad evaluates that expression five times, once for
value taken by the range variable.

Range variables are crucial to exploiting Mathcad’s capabilities to their fullest. T
section shows how to define and use range variables to perform iteration. For a 
description of more advanced iterative operations made possible by the program
operators in Mathcad Professional, turn to Chapter 15, “Programming.”

Defining and using range variables 

To define a range variable, type the variable name followed by a colon and a ran
values. For example, here’s how to define the variable j ranging from 0 to 15 in steps
of 1:

■ Type j  and then press the colon key (: ), 

or click  on the Arithmetic toolbar. 
The empty placeholder indicates that 
Mathcad expects a definition for j. At this point, Mathcad does not know whethe
j is to be a conventional variable or a range variable. 

■ Type 0. Then press the semicolon key (; ), 

or click  on the Arithmetic toolbar. 
This tells Mathcad that you are defining a 
range variable. Mathcad shows the semicolon as two periods “..” to indicate a ra
Complete the range variable definition by typing 15  in the remaining placeholder.

This definition indicates that j now takes on the values . To define a rang
variable that changes in steps other than 1, see the section “Types of ranges” on
127. 

Once you define a range variable, it takes on its complete range of values every time 
you use it. If you use a range variable in an equation, for example, Mathcad must
evaluate that equation once for each value of the range variable.

You must define a range variable exactly as shown above. There must be:

■ a variable name on the left,

0 1 2…15, ,
Defining and evaluating variables 125
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■ either a “:=” or a “≡” in the middle, and

■ a valid range on the right.

Note You cannot define a variable in terms of a range variable. For example, if after having definj 
as shown you now define , Mathcad assumes you are trying to set a scalar varia
equal to a range variable and marks the equation with an appropriate error message.

One application of range variables is to fill up the elements of a vector or matrix. 
can define vector elements by using a range variable as a subscript. For examp
define  for each value of j:

■ Type x[j:j^2 [Space ]+1.

Figure 8-4 shows the vector of values computed by this equation. Since j is a range 
variable, the entire equation is evaluated once for each value of j. This defines  for 
each value of j from 0 to 15. 

Figure 8-4: Using a range variable to define the values of a vector.

To understand how Mathcad computes with range variables, keep in mind this fu
mental principle: 

If you use a range variable in an expression, Mathcad evaluates the expression 
for each value of the range variable.    

If you use two or more range variables in an equation, Mathcad evaluates the equ
once for each value of each range variable. 

i j 1+:=

xj

xj
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Tip Mathcad takes longer to compute equations with ranged expressions since there may be
computations for each equation. While Mathcad is computing, the mouse pointer change
appearance. To learn how to interrupt a calculation in progress, see “Interrupting calculat
on page 144.

Types of ranges 

The definition of j in the previous section, ranging from 0 to 15, is an example of t
simplest type of range definition. But Mathcad permits range variables with value
ranging from any value to any other value, using any constant increment or decre

To define an arbitrary range variable, type an equation of this form:

k:1,1.1;2

This appears in your document window as:

In this range definition: 

■ The variable k is the name of the range variable itself. It must be a simple nam
No subscripts or function definitions are allowed.

■ The number 1 is the first value taken by the range variable k.

■ The number 1.1 is the second value in the range. Note that this is not the step size. 
The step size in this example is 0.1, the difference between 1.1 and 1. If you 
the comma and the 1.1, Mathcad assumes a step size of one in whatever dir
(up or down) is appropriate.

■ The number 2 is the last value in the range. In this example, the range values
constantly increasing. If instead you had defined , then k would count 
down from 10 to 1. Even if the third number in the range definition is not an e
number of increments from the starting value, the range will not go beyond it.
example, if you define  then k takes values 10, 20, 30, . . ., 60.

Note You can use arbitrary scalar expressions in range definitions. However, these values mus
always be real numbers. Note also that if you use a fractional increment for a range variable,
will not be able to use that range variable as a subscript because subscripts must be inte

k 1 1.1 2..,:=

k 10 1..:=

k 10 20 65..,:=
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Defining and evaluating functions 

As described in Chapter 10, “Built-in Functions,” Mathcad has an extensive built-
function set. You can augment Mathcad’s built-in function set by defining your ow
functions.

You define a function in much the same way you define a variable. The name goe
the left, a definition symbol goes in the middle, and an expression goes on the ri
The main difference is that the name includes an argument list. The example below 
shows how to define a function called dist(x, y) that returns the distance between the
point (x, y) and the origin.

To type such a function definition:

■ Type the function name. 

■ Type a left parenthesis followed by one or 
more names separated by commas. Com-
plete this argument list by typing a right 
parenthesis. 

Note It makes no difference whether or not the names in the argument list have been defined o
elsewhere in the worksheet. What is important is that these arguments must be names. They 
cannot be more complicated expressions. 

■ Press the colon (: ) key, or click  on 
the Arithmetic toolbar. You see the defi-
nition symbol (:=).

■ Type an expression to define the function. 
In this example, the expression involves 
only the names in the argument list. In 
general though, the expression can contain 
any previously defined functions and vari-
ables as well.

Once you have defined a function, you can use it anywhere below and to the rig
the definition, just as you would use a variable.

When you evaluate an expression containing a function, as shown in Figure 8-5
Mathcad:

■ evaluates the arguments you place between the parentheses,

■ replaces the dummy arguments in the function definition with the actual argum
you place between the parentheses, 
128  Chapter 8  Calculating in Mathcad
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■ performs whatever arithmetic is specified by the function definition,

■ returns the result as the value of the function.

Figure 8-5: A user-defined function to compute the distance to the origin.

The arguments of a user-defined function can represent scalars, vectors, or mat
For example, you could define the distance function as .This is
example of a function that accepts a vector as an argument and returns a scalar
See Chapter 11, “Vectors, Matrices, and Data Arrays,” for more information. 

Note Function names are font sensitive. The function f(x) is different from the function f(x). 
Mathcad’s built-in functions, however, are defined for all fonts (except the Symbol font), si
and styles. This means that sin(x), sin(x), and sin (x) all refer to the same function. 

Variables in user-defined functions 

When you define a function, you don’t have to define any of the names in the argu
list since you are telling Mathcad what to do with the arguments, not what they are. 
When you define a function, Mathcad doesn’t even have to know the types of th
arguments—whether the arguments are scalars, vectors, matrices, and so on. It 
when Mathcad evaluates a function that it needs to know what the argument types

However, if in defining a function you use a variable name that is not in the argument 
list, you must define that variable name above the function definition. The value of
variable at the time you make the function definition then becomes a permanent 
of the function. This is illustrated in Figure 8-6.

dist v( ) v0
2 v1

2+:=
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Figure 8-6: The value of a user function depends on its arguments.

If you want a function to depend on the value of a variable, you must include tha
variable as an argument. If not, Mathcad just uses that variable’s fixed value at the
in the worksheet where the function is defined.

Recursive function definitions

Mathcad supports recursive function definitions—you may define the value of a 
function in terms of a previous value of the function. As shown in Figure 8-7, recur
functions are useful for defining arbitrary periodic functions, as well as elegantly 
implementing numerical functions like the factorial function.

Note that a recursive function definition should always have at least two parts:

■ An initial condition that prevents the recursion from going forever.

■ A definition of the function in terms of some previous value(s) of the function.

Note If you do not specify an initial condition that stops the recursion, Mathcad generates a “st
overflow” error message when you try to evaluate the function.

Pro The programming operators in Mathcad Professional also support recursion. Se
section “Programs within programs” in Chapter 15 for examples.
130  Chapter 8  Calculating in Mathcad
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Figure 8-7: Mathcad allows recursive function definitions.

Units and dimensions

When you first start Mathcad, a complete set of units is available for your calculati
You can treat these units just like built-in variables. To assign units to a number 
expression, just multiply it by the name of the unit. 

Mathcad recognizes most units by their common abbreviations. Lists of all of Ma
cad’s built-in units in several systems of units are in the Appendices. By default 
Mathcad uses units from the SI unit system (also known as the International System
Units) in the results of any calculations, but you may use any supported units you w
in creating your expressions. See “Displaying units of results” on page 138 for m
information about selecting a unit system for results.

For example, type expressions like the following:

mass:75*kg

acc:100*m/s^2

acc_g:9.8*m/s^2

F:mass*(acc + acc_g)

Figure 8-8 shows how these equations appear in a worksheet.
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Figure 8-8: Equations using units.

Tip If you define a variable which consists of a number followed immediately by a unit name, 
can omit the multiplication symbol; Mathcad inserts a space and treats the multiplication a
implied. See the definition of mass at the bottom of Figure 8-8. 

You can also use the Insert Unit dialog box to insert one of Mathcad’s built-in un
into any placeholder. To use the Insert Unit dialog box:

■ Click in the empty placeholder and choose Unit  from the Insert menu, or click  
on the Standard toolbar. Mathcad opens the Insert Unit dialog box.

■ The list at the bottom shows built-in 
units, along with their Mathcad names, 
corresponding to whatever physical 
quantity is selected in the top scrolling 
list. When “Dimensionless” is selected 
at the top, a list of all available built-in 
units shows on the bottom.

■ If necessary, use the top scrolling list to 
display only those units corresponding 
to a particular physical quantity. This 
makes it easier to find a particular unit 
or to see what choices are appropriate.

■ In the bottom list, double-click the unit you want to insert, or click the unit you w
and then click “Insert.” Mathcad inserts that unit into the empty placeholder.
132  Chapter 8  Calculating in Mathcad
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Note Mathcad performs some dimensional analysis by trying to match the dimensions of your se
result with one of the common physical quantities in the top scrolling list. If it finds a matc
you’ll see all the built-in units corresponding to the highlighted physical quantity in the bot
scrolling list. If nothing matches, Mathcad simply lists all available built-in units on the bott

Dimensional checking

Whenever you enter an expression involving units, Mathcad checks it for dimensi
consistency. If you add or subtract values with incompatible units, or violate othe
principles of dimensional analysis, Mathcad displays an appropriate error messa

For example, suppose you had defined acc 
as  instead of  as 
shown at right. Since acc is in units of 
velocity and acc_g is in units of accelera-
tion, it is inappropriate to add them togeth-
er. When you attempt to do so, Mathcad 
displays an error message. 

Other unit errors are usually caused by one
of the following:   

■ An incorrect unit conversion.

■ A variable with the wrong units.

■ Units in exponents or subscripts (for example  or ). 

■ Units as arguments to inappropriate functions (for example, ).

Defining your own units

Although Mathcad recognizes many common units, you may need to define your 
unit if that unit isn’t one of Mathcad’s built-in units or if you prefer to use your ow
abbreviation instead of Mathcad’s abbreviation.

Note Although absolute temperature units are built into Mathcad, the Fahrenheit and Celsius 
temperature units are not. See the QuickSheet “Temperature Conversions” in the Resour
Center for examples of how to define these temperature scales and to convert between th

You define your own units in terms of existing units in exactly the same way you wo
define a variable in terms of an existing variable. Figure 8-9 shows how to define
units as well as how to redefine existing units.

100 m s⁄⋅ 100 m s2⁄⋅

v3 acre⋅ 23 f t⋅

0 henry⋅( )sin
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Figure 8-9: Defining your own units.

Note Since units behave just like variables, you may run into unexpected conflicts. For exampl
you define the variable m in your worksheet, you won’t be able to use the built-in unit m for 
meters anywhere below that definition. However, Mathcad automatically displays the unit m in 
any results involving meters, as described in “Displaying units of results” on page 138.

Working with results 

Formatting results

The way that Mathcad displays numbers (the number of decimal places, whether t
i or j for imaginary numbers, and so on) is called the result format. You can set the 
result format for a single calculated result or for an entire worksheet.

Setting the format of a single result

When you evaluate expressions numerically in Mathcad, results are formatted in
worksheet according to the worksheet default result format. You can modify the fo
for a single result as follows:

■ Click anywhere in the equation whose 
result you want to format. 
134  Chapter 8  Calculating in Mathcad
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■ Choose Result from the 
Format menu. Alterna-
tively, double-click the 
equation itself. The Re-
sult Format dialog box 
appears. 

■ Change the desired set-
tings. See below to learn 
about the various settings 
and their allowed values. 
To display the six decimal 
places shown below, you 
would increase “Displayed precision” from 3 to 6. Settings that are grayed can 
be changed for the entire worksheet, as described in“Setting worksheet defa
format” on page 137.

■ Click “OK.” Mathcad redisplays the result 
using the new format.

To redisplay a result using the worksheet default result format settings, click on 
result to enclose the result between the editing lines, delete the equal sign, and p= 
to replace the equal sign. The result is now restored to the default worksheet se

Note When the format of a result is changed, only the appearance of the result changes in the 
worksheet. Mathcad continues to maintain full precision internally for that result. To see a
number as it is stored internally, click on the result, press [Ctrl ][Shift ]N, and look on the 
message line at the bottom of the Mathcad window. If you copy a result, however, Mathca
copies the number only to the precision displayed.

This is the meaning of each of the settings in the Result Format dialog box:

Displayed precision
Enter an integer between 0 and 15. The default is 3. This controls the numbe
displayed digits to the right of the decimal point, equalling the lesser of Displa
Precision and (16 – the number of digits to the left of the decimal point). Math
maintains 16 digits of precision internally. 

Show trailing zeros
Check this box to make all displayed results have as many digits to the right o
decimal point as required by the current choice of Displayed Precision. For exam
with Displayed Precision set to 3, Mathcad displays 5 as 5.000.

Exponential threshold
Enter an integer n between 0 and 15. Mathcad shows computed results of magnit
greater than  or smaller than  in exponential notation. When the thres10n 10 n–
Working with results 135
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is 3, numbers like 30,000 are displayed as  instead of 30,000. The defaul

Complex threshold
Enter an integer n between 0 and 63. If the ratio between the real and imagina
part of a complex number is less than  or greater than , then the sma
part is not shown. The default setting is 10. This means that numbers like 
appear simply as 1. 

Zero threshold
Enter an integer n between 0 and 307. Numbers less than  are shown as z
The default setting is 15. This means numbers of magnitude less than  ap
as zero. This value can only be set for the entire worksheet. 

Radix
Set the radix (base) in which results are displayed. The default is decimal. He
decimal results are indicated by the letter “h” after the number, octal results by the
letter “o,” and binary results by the letter “b.” Mathcad does not reliably show 
hexadecimal, octal, or binary numbers of magnitude greater than .   

Imaginary value
Select either i or j from the drop-down list to indicate an imaginary result. The 
default is i. You can use either i or j in equations you create—Mathcad always 
understands both. The selection you make here tells Mathcad which one to use
it gives you a complex answer. See “Inserting math” on page 46 for more info
tion on how to enter complex numbers. This value can only be set for the ent
worksheet. 

Matrix display style
Choose Matrix here to display a result array in traditional matrix style, with brack
surrounding the elements. Choose Table to display a result array in a resizab
scrolling output table, similar to a spreadsheet. Choose Automatic, the defau
have Mathcad choose a matrix display for result arrays having fewer than nine 
or columns, and an output table display for larger arrays. See “Displaying arr
on page 226 for more information on output tables.

Expand nested arrays
Check this box to see nonscalar array elements displayed in expanded form. N
arrays (see “Nested arrays” on page 233) may only be expanded if the result
displayed as a matrix. If a nested array is displayed as a table, you can tempo
expand an element by choosing Down One Level from the pop-up menu. 

Format units
Check this box to see units in a result formatted wherever possible as a built-
fraction containing units with positive exponents only rather than as a produc
units with positive and negative exponents (e.g., ). See “Displaying unit
results” on page 138 for more information about units in results.

Simplify units when possible
Check this box to see units in a result expressed wherever possible in derived
(e.g., N) rather than in fundamental units (e.g., ).

Figure 8-10 shows the same number formatted several different ways.

3 104⋅

10n 10 n–

1 10 12– i+

10n

10 15–

231

m s 2–⋅

kg m s 2–⋅ ⋅
136  Chapter 8  Calculating in Mathcad



 

ly 

in 
 result 
 your 

mplex 
 

ning 
, 

he 
 
 –1. 

Mathcad Users Guide.book  Page 137  Sunday, August 9, 1998  2:59 PM
Figure 8-10: Several ways to format the same number.

Setting worksheet default format 

To change the default display of numerical results in your worksheet:

■ Click on a particular numerical result as described above.

■ Choose Result from the Format menu. Check “Set as default” if it is not already
checked.

■ Change the desired settings in the Result Format dialog box.

■ Click “OK.” 

Mathcad changes the display of all results whose formats have not been explicit
specified. 

Tip Changing the worksheet default result format affects only the worksheet you are working 
when you make the change. Any other worksheets open at the time retain their own default
formats. If you want to re-use your default result formats in other Mathcad worksheets, save
worksheet as a template as described in Chapter 7, “Worksheet Management.”

Complex results

Complex numbers can arise in results if you enter an expression that contains a co
number. Even a Mathcad expression that involves only real numbers can have a
complex value. For example, if you evaluate , Mathcad returns i. See Figure 8-11 
for examples.

Note When complex numbers are available, many functions and operators we think of as retur
unique results become multivalued. In general, when a function or operator is multivalued
Mathcad returns the principal value: the value making the smallest positive angle relative to t
positive real axis in the complex plane. For example, when it evaluates , Mathcad
returns  despite the fact that we commonly think of the cube root of –1 as being

1–

1–( )1 3⁄

.5 .866i+
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This is because the number  makes an angle of only 60 degrees from the positiv
axis. The number –1, on the other hand, is 180 degrees from the positive real axis. Mathc
nth root operator returns –1 in this case, however.

Figure 8-11: Examples of complex results.

Displaying units of results   

Mathcad by default displays results in terms of the fundamental units of the unit sy
you’re working with. Mathcad offers the following unit system choices: SI, CGS, MKS, 
U.S. customary units, or no unit system (see below).

Tip Check “Simplify units when possible” in the Result Format dialog box (see page 134)to see
in a result expressed in terms of derived units rather than in base units. Check “Format un
see units in a result displayed as a built-up fraction containing terms with positive expone
only rather than as a product of units with positive and negative exponents.

You can have Mathcad redisplay a particular result in terms of any of Mathcad’s b
in units. To do so:

■ Click in the result. You’ll see an empty placeholder to its right. This is the units 
placeholder.

■ Click the units placeholder and choose Unit  from the Insert menu, or click  on 
the Standard toolbar. Mathcad opens the Insert Unit dialog box. This is descr
in “Units and dimensions” on page 131.

■ Double-click the unit in which you want to display the result. Mathcad inserts t
unit in the units placeholder.

.5 .866i+
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Note For some engineering units—such as hp, cal, BTU, and Hz—Mathcad adopts one common 
definition for the unit name but allows you to insert one of several alternative unit names,
corresponding to alternative definitions of that unit, in your results. In the case of horsepo
for example, Mathcad uses the U.K. definition of the unit hp but gives you several variants, such
as water horsepower, metric horsepower, boiler horsepower, and electric horsepower. 

Another way to insert a unit is to type its name directly into the units placeholder. T
method is more general since it works not only for built-in units but for units you’
defined yourself and for combinations of units.

Unit systems 

When you start Mathcad, the SI system of units is loaded by default. This means th
when you use the equal sign to display a result having units, Mathcad automatic
displays the units in the result in terms of base or derived SI units. 

You can have Mathcad display results 
in terms of the units of any of the other 
built-in unit systems in Mathcad: CGS, 
US customary, MKS, or no unit system 
at all. To do so, choose Options from 
the Math menu and click the Unit Sys-
tem tab. You will see a dialog box like 
the one shown at right.

Select the default unit system in which 
you want to display results. The SI unit 
system, widely used by scientists and 
engineers in many countries, provides 
two additional base units over the other 
systems, one for luminosity (candela) 
and one for substance (mole), and the base SI electrical unit (ampere) differs from the 
base electrical unit in the other systems (coulomb).

The following table summarizes the base units available in Mathcad’s unit system

Unit System Base Units

SI m, kg, s, A, K, cd, and mole

MKS m, kg, sec, coul, and K

CGS cm, gm, sec, coul, and K

U.S. ft, lb, sec, coul, and K

None Displays results in terms of fundamental dimensions of length, m
time, charge, and absolute temperature. All built-in units are disab
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The standard SI unit names—such as A for ampere, L for liter, s for second, and S for 
siemens—are generally available only in the SI unit system. Many other unit names ar
available in all the available systems of units. For a listing of which units are avail
in each system, see the Appendices. Mathcad includes most units common to sci
and engineering practice. Where conventional unit prefixes such as m- for milli -, n- for 
nano-, etc. are not understood by Mathcad, you can easily define custom units su

 as described in “Defining your own units” on page 133. 

Tip For examples of units with prefixes not already built into Mathcad, see the QuickSheets in
on-line Resource Center.

If you click “None” in the Unit System tab of the Math Options dialog box, Mathc
doesn’t understand any built-in units, and displays answers in terms of the fundam
dimensions of length, mass, time, charge, and temperature. However, even if you are 
working in one of Mathcad’s built-in unit systems, you can always choose to see re
in your worksheet displayed in terms of fundamental dimension names rather tha
base units of the unit system. To do so:

■ Choose Options from the Math  menu. 

■ Click the Dimensions tab.

■ Check “Display dimensions.”

■ Click “OK.”

Unit conversions

There are two ways to convert from one set of units to another:

■ By using the Insert Unit dialog box, or

■ By typing the new units in the units placeholder itself.

To convert units using the Insert Unit dialog box:

■ Click the unit you want to replace.

■ Choose Unit  from the Insert menu, or click  on the Standard toolbar.

■ In the scrolling list of units, double-click the unit in which you want to display t
result. 

As a quick shortcut, or if you want to display the result in terms of a unit not availa
through the Insert Unit dialog box—for example, a unit you defined yourself or a
algebraic combination of units—you can edit the units placeholder directly.

Figure 8-12 shows F displayed both in terms of fundamental SI units and in terms of 
several combinations of units.

When you enter an inappropriate unit in the units placeholder, Mathcad inserts a
combination of base units that generate the correct units for the displayed result

µm
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example, in the last equation in Figure 8-12,  is not a unit of force. Mathca
therefore inserts  to cancel the extra length dimension.

Figure 8-12: A calculated result displayed with different units.

Whenever you enter units in the units placeholder, Mathcad divides the value to
displayed by whatever you enter in the units placeholder. This ensures that the com
displayed result—the number times the expression you entered for the placeholder
is a correct value for the equation.

Note Conversions involving an offset in addition to a multiplication, for example gauge pressur
absolute pressure, or degrees Fahrenheit to Celsius, cannot be performed directly with 
Mathcad’s unit conversion mechanism. You can, however, perform conversions of this typ
defining suitable functions. See the QuickSheet “Temperature Conversions” in the Resou
Center for examples of temperature conversion functions.

You can enter any variable, constant, or expression in a units placeholder. Mathca
then redisplays the result in terms of the value contained in the units placeholder
example, you can use the units placeholder to display a result as a multiple of π or in 
engineering notation (as a multiple of , , etc.). 

Tip You can also use the units placeholder for dimensionless units like degrees and radians. M
treats the unit rad as a constant equal to 1, so if you have a number or an expression in rad
you can type deg into the units placeholder to convert the result from radians to degrees. 

kW s⋅
m 1–

103 106
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Copying and pasting numerical results

You can copy a numerical result and paste it either elsewhere in your worksheet o
a new application. See “Displaying arrays” on page 226 for information on copyi
and pasting arrays.

To copy a single number appearing to the right of an equal sign:

■ Click on the result to the right of the equal sign. This puts the result between 
editing lines.

■ Choose Copy from the Edit  menu, or click  on the Standard toolbar. This plac
the result on the Clipboard.

■ Click wherever you want to paste the result. If you’re pasting into another app
tion, choose Paste from that application’s Edit  menu. If you’re pasting into a 

Mathcad worksheet, choose Paste from Mathcad’s Edit  menu or click  on the 
Standard toolbar.

When you paste a numerical result into a Mathcad worksheet, it appears as:

■ A math region consisting of a number if you paste it into empty space.

■ A number if you paste it into a placeholder in a math region.

■ A number if you paste it directly into text or into a placeholder in text created us
the Math Region command on the Insert menu.

Note The Copy command copies the numerical result only to the precision displayed. To copy t
result in greater precision, double-click it and increase “Displayed Precision” on the Resu
Format dialog box. Copy does not copy units and dimensions from a numerical result.

Controlling calculation 

When you start Mathcad, you are in automatic mode. This means that Mathcad update
results in the worksheet window automatically. You can tell you’re in automatic m
because the word “Auto” appears in the message line.

If you don’t want to wait for Mathcad to make computations as you edit, you can dis
automatic mode by choosing Automatic Calculation from the Math  menu. The word 
“Auto” disappears from the message line and the check beside Automatic Calculation 
disappears to indicate that automatic mode is now off. You are now in manual mode.
142  Chapter 8  Calculating in Mathcad
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Tip The calculation mode—either manual or automatic—is a property saved in your Mathcad
worksheet. As described in Chapter 7, “Worksheet Management,” the calculation mode is
a property saved in Mathcad template (MCT) files. 

Calculating in automatic mode

Here is how Mathcad works in automatic mode:

■ As soon as you press the equal sign, Mathcad displays a result.

■ As soon as you click outside of an equation having a “:=” or a “≡,” Mathcad 
performs all calculations necessary to make the assignment statement.

When you process a definition in automatic mode by clicking outside the equatio
region, this is what happens:

■ Mathcad evaluates the expression on the right side of the definition and assig
to the name on the left.

■ Mathcad then takes note of all other equations in the worksheet that are in any
affected by the definition you just made.

■ Finally, Mathcad updates any of the affected equations that are currently visib
the worksheet window. 

Note Although the equation you altered may affect equations throughout your worksheet, Math
performs only those calculations necessary to guarantee that whatever you can see in the w
is up-to-date. This optimization ensures you don’t have to wait for Mathcad to evaluate 
expressions that are not visible. If you print or move to the end of the worksheet, howeve
Mathcad automatically updates the whole worksheet.

Whenever Mathcad needs time to complete computations, the mouse pointer ch
its appearance and the word “WAIT” appears on the message line. This can occur wh
you enter or calculate an equation, when you scroll, during printing, or when you
enlarge a window to reveal additional equations. In all these cases, Mathcad eva
pending calculations from earlier changes.

As Mathcad evaluates an expression, it surrounds it with a green rectangle. This m
it easy to follow the progress of a calculation.

To force Mathcad to recalculate all equations throughout the worksheet, choose
Calculate Worksheet from the Math  menu.

Calculating in manual mode

In manual mode, Mathcad does not compute equations or display results until yo
specifically request it to recalculate. This means that you don’t have to wait for Mat
to calculate as you enter equations or scroll around a worksheet.
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Mathcad keeps track of pending computations while you’re in manual mode. As s
as you make a change that requires computation, the word “Calc” appears on th
message line. This is to remind you that the results you see in the window are no
to-date and that you must recalculate them before you can be sure they are upd

You can update the screen by choosing Calculate from the Math  menu or clicking 

 on the Standard toolbar. Mathcad performs whatever computations are nece
to update all results visible in the worksheet window. When you move down to se
more of the worksheet, the word “Calc” reappears on the message line to indicat
you must recalculate to see up-to-date results.

To process the whole worksheet, including those portions not visible in the works
window, choose Calculate Worksheet from the Math  menu.

Note When you print a worksheet in manual calculation mode, the results on the printout are n
necessarily up-to-date. In this case, make sure to choose Calculate Worksheet from the Math  
menu before you print.

Interrupting calculations   

To interrupt a computation in progress:

■ Press [Esc ]. The dialog box shown at right appears.

■ Click “OK” to stop the calculations or “Cancel” to resume 
calculations.

If you click “OK,” the equation that was being processed when 
you pressed [Esc ] is marked with an error message (see “Error 
messages” on page 147) indicating that calculation has been interrupted. To resu
interrupted calculation, first click in the equation having the error message, then ch

Calculate from the Math  menu or click  on the Standard toolbar.

Tip If you find yourself frequently interrupting calculations to avoid having to wait for Mathcad
recalculate as you edit your worksheet, you can switch to manual mode as described abo

Disabling equations 

You can disable a single equation so that it no longer calculates along with other reg
in your worksheet. Disabling an equation does not affect Mathcad’s equation edi
formatting, and display capabilities.

To disable calculation for a single equation in your worksheet, follow these steps

■ Click on the equation you want to disable.
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■ Choose Properties from the Format menu, and click the Calculation tab.

■ Under “Calculation Options” check “Disable Evaluation.” 

■ Mathcad shows a small rectangle after the 
equation to indicate that it is disabled. An 
example is shown at right.

Tip An easy shortcut for disabling evaluation is to click with the right mouse button on an equa
and select Disable Evaluation from the pop-up menu.

To re-enable calculation for a disabled equation:

■ Click on the equation to select it.

■ Choose Properties from the Format menu, and click the Calculation tab.

■ Remove the check from “Disable Evaluation.” 

Mathcad removes the small rectangle beside the equation, and calculation is re-en

Animation

This section describes how to use Mathcad to create and play short animation cli
using the built-in variable FRAME. Anything that can be made to depend on this variab
can be animated. This includes not only plots but numerical results as well. You 
play back the animation clips at different speeds or save them for use by other 
applications.

Creating an animation clip

Mathcad comes with a predefined constant called FRAME whose sole purpose is to 
drive animations. The steps in creating any animation are as follows:

■ Create an expression or plot, or a group of expressions, whose appearance ultim
depends on the value of FRAME. This expression need not be a graph. It can be
anything at all. 
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■ Choose Animate from the View 
menu to bring up the Animate dialog 
box.

■ Drag-select the portion of your work-
sheet you want to animate as shown in 
Figure 8-13. Draw a rectangle around 
as many regions as you want to appear 
in the animation.

■ Set the upper and lower limits for 
FRAME in the dialog box. When you 
record the animation, the FRAME variable increments by one as it proceeds from
the lower limit to the upper limit.

■ Enter the playback speed in the Frames/Sec. box. 

■ Click “Animate.” You’ll see a miniature rendition of your selection inside the dial
box. Mathcad redraws this once for each value of FRAME. This won’t necessarily 
match the playback speed since at this point you’re just creating the animation.

To save your animation clip as a Windows AVI  file, suitable for viewing in other 
Windows applications, click “Save As” in the dialog box. 

Figure 8-13: Selecting an area of a worksheet for animation.

Tip Since animation clips can take considerable disk space, Mathcad saves them in compres
format. Before creating the animation, you can choose what compression method to use 
whether to compress at all. To do so, click “Options” in the Animate dialog box. 

Playing an animation clip

As soon as you’ve created an animation clip as described in the previous section
Mathcad opens a Playback window:
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The first frame of the animation clip you just created is already 
in the window. To play back the animation clip, click the arrow 
at the lower left corner of the window. You can also play back 
the animation clip on a frame by frame basis, either forward 
or backward. To do so, drag the slider below the animated 
picture to the left or right.

Tip You can control the playback speed by clicking the button to the right of the play button, w
then opens a pop-up menu. Choose Speed from the menu and adjust the slider control. 

Playing a previously saved animation

If you have an existing Windows AVI  file on your disk, you can play it within Mathcad.
To do so:

■ Choose Playback from the View menu to 
bring up the Playback dialog box. The win-
dow is collapsed since no animation clip has 
been opened. 

■ Click on the button to the right of the play button and choose Open from the menu. 
Use the Open File dialog box to locate and open the AVI  file you want to play.

Once you’ve loaded a Windows AVI  file, proceed as described in the previous sectio

Tip To launch an animation directly from your worksheet, you can insert a hyperlink to an AVI
by choosing Hyperlink  from the Insert menu. You can also embed a shortcut to the AVI file 
your worksheet by dragging the icon for the AVI file from the Windows Explorer and dropp
it into your worksheet. Finally, you can embed or link an OLE animation object in your 
worksheet (see “Inserting objects” on page 95).

Error messages 

If Mathcad encounters an error when evaluating an expression, it marks the expre
with an error message and highlights the offending name or operator in red.

An error message is visible only when you click on the associated expression. Figur
8-14 shows how an error message looks when you click on an expression. 
Error messages 147



a 
 can 
e 

ibed 
ose 

ion to 
k in 
 click 

hcad 
putes 

 it in 
e real 
et. 

Mathcad Users Guide.book  Page 148  Sunday, August 9, 1998  2:59 PM
 

Figure 8-14: An error message and an undefined variable.

Tip You can get on-line help about any error message by clicking on it and pressing [F1]. 

Mathcad cannot process an expression containing an error. If the expression is 
definition, the variable or function it is supposed to define remains undefined. This
cause any expressions that reference that variable to be undefined as well. In th
example shown in Figure 8-14, an error in the definition of x1 causes the expression 
following the definition to be undefined.

Fixing errors 

If your worksheet contains several expressions with errors, this is what to do:

■ Determine which expression with an error is closest to the top of the worksheet. 
This error is probably the cause of many of the other errors.

■ If you anticipate time-consuming calculations, switch to manual mode as descr
in “Controlling calculation” on page 142. When you are ready to recalculate, cho

Calculate from the Math  menu or click  on the Standard toolbar turn. 
Alternatively, turn on automatic mode again.

Once you have determined which expression caused the error, edit that express
fix the error or change the variable definitions that led to the error. When you clic
the expression and begin editing, Mathcad removes the error message. When you
outside the equation (or in manual calculation mode, when you recalculate), Mat
recomputes the expression. Once you have fixed the error, Mathcad then recom
the other expressions affected by the expression you changed.

Note When you define a function, Mathcad does not try to evaluate it until you subsequently use
the worksheet. If there is an error, the use of the function is marked in error, even though th
problem may lie in the definition of the function itself, possibly much earlier in the workshe
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